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Chapter 1

Introduction
This document provides guidelines for installing Content Server on WebLogic Server, 
connecting to the supported database of your choice.

This chapter provides information that will help you prepare for the Content Server 
installation. It contains the following sections:
• About This Guide
• Installation Quick Reference

Note

For the complete list of currently supported third-party products, refer to 
the Supported Platform Document (SPD) for this version of Content 
Server. The SPD is accessible from the e-docs site: 

http://e-docs.fatwire.com

To obtain your user name and password, contact FatWire Technical 
Support.
Anyone using this guide is expected to have experience installing and 
configuring databases, web servers, and application servers. Only selected 
information regarding the configuration of third-party products is given in 
this guide. For detailed information about a particular third-party product, 
refer to that product’s documentation.
Installing Content Server 7.0.3 with WebLogic Server



Chapter 1.  Introduction

 About This Guide
6

About This Guide
This guide covers the installation, configuration, and maintenance of WebLogic Server, as 
required to support Content Server. This includes configuration of a domain with admin 
and managed servers, vertical clusters, and backend databases. The last chapter in this 
guide shows you how to install Content Server.

How This Guide is Organized
The content of this guide is organized by function rather than the order in which 
installation steps are completed. For example, a function such as application deployment 
is associated with the application server. It is presented in Part II (which covers the 
application server), even though it is performed later, when Content Server is installed 
(Part IV). Each major component of the Content Server installation is covered in its own 
part. A summary of the installation steps in the required order is given at the end of this 
chapter (see “Installation Quick Reference,” on page 7).

Graphics in This Guide
Many steps in this guide display screen captures of dialog boxes and similar windows that 
you interact with in order to complete the steps. The screen captures are shown to help you 
follow the installation process. They are not intended to be sources of specific 
information, such as parameter values, options to select, or product version number.

Paths and Directories

This guide uses the following paths and directories:

Note

Screen captures in this guide reflect the interface for WebLogic Server 9.2. In 
higher supported versions, WebLogic Server dialog boxes and other interface 
elements may differ in appearance from the elements shown in this guide. 
However, their functions remain the same.

Note

In this guide, paths for web installations are based on WebLogic 9.2. For higher 
supported versions, WebLogic Server paths differ as shown in Table 1.

Table 1: Paths and Directories

Name used by guide Description

<domain_home> Path to the WebLogic domain; the path includes the 
domain name.

<cs_install_dir> Path to the directory where Content Server is installed; the 
path does not include the name of the Content Server 
application.
Installing Content Server 7.0.3 with WebLogic Server
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Installation Quick Reference
After you install and configure the J2EE components that support Content Server, you will 
run the Content Server installer, which will guide you through the installation process. 
You will run the installer on each development, delivery, and management system on 
which you plan to use Content Server. During the Content Server installation, you will 
have the option to install sample sites and sample content.

The steps below summarize the installation and configuration of Content Server and its 
supporting software. Keep the steps handy as a quick reference to installation procedures 
and to chapters that provide detailed instructions.

<bea_home> Path to the directory where WebLogic is installed; the path 
includes the name of the directory. 

<shared_dir> Path to the shared folder on the given system; the path 
includes the name of the shared folder.

<bea_home>/
weblogic92

WebLogic Server directory used throughout this guide. 
If you are using WebLogic 10, replace this path with the 
following:
<bea_home>/wlserver_10.0

<bea_home>/
workshop92

WebLogic Workshop directory used throughout this guide. 
If you are using WebLogic 10, replace this path with the 
following:
<bea_home>/workshop_10.0

<deploy_dir> Path to the directory to which Content Server is deployed. 
The path includes the name of the deployment directory.

<content_dir> Portal installations only. The content directory inside the 
directory containing your WebLogic Portal Web project.

Note

The names of the systems in your Content Server environment might differ from 
the names used in this document. Typically, the management system is also called 
“staging,” and the delivery system is also called “production.”

Table 1: Paths and Directories (continued)

Name used by guide Description
Installing Content Server 7.0.3 with WebLogic Server
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To install Content Server and its supporting software

Complete the steps below for each development, content management, and production 
environment.

I. Set Up the Database
Set up your choice of supported databases by installing the database management system, 
creating a database for Content Server, and configuring the database. For instructions, 
refer to our configuration guide, Configuring Third-Party Software.

II. Set Up the Application Server
1. Install WebLogic Server. For instructions, see Chapter 3, “Installing WebLogic Server.”

2. Depending on the type of installation you are creating (web or portal), do one of the 
following:
- For web installations, create and configure a WebLogic server domain, as shown 

in “Creating and Configuring a WebLogic Server Domain,” on page 26. This step 
requires you to:
1) Create an admin server for the domain.
2) Create a managed server for a production environment and, if you choose to 

set up vertical clustering, a managed server for each cluster member.
3) Name the domain.

- For portal installations, create and configure a WebLogic portal domain, as shown 
in “Creating and Configuring a WebLogic Portal Domain,” on page 50. The 
corresponding admin server is created for you automatically when you create the 
portal domain.

3. Set up the environment for deployment and database communications. Depending on 
the type of installation you are creating (web or portal), this step requires you to:
a. Set environment variables to ensure that all servers are using the correct JDK. For 

instructions, see “Setting Environment Variables,” on page 39.

Note

Before installing Content Server, take note of the following instructions:
• Refer to the Supported Platform Document (SPD) for Content Server 7.0.3 to 

ensure you are installing currently supported third-party products. The SPD is 
accessible from the e-docs site:  http://e-docs.fatwire.com
(To obtain a user name and password, contact FatWire Technical Support.)

• When you are ready to install Content Server, you will install version 7.0.2, 
run the CS 7.0.3 rollup installer, and follow up with post-installation steps. 

Note

This chapter also contains commands for starting and stopping the servers that 
are used in this guide.
Installing Content Server 7.0.3 with WebLogic Server
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b. (Optional) Turn off host name verification for non-production systems. For 
instructions, see “(Optional) Disabling Host Name Verification,” on page 39.

c. (Web installations only) Enable HTTP tunneling on all servers on which Content 
Server will be deployed. Enabling tunneling enables you to run commands using 
the weblogic.Deployer utility (which deploys Content Server.) For 
instructions, see “Enabling HTTP Tunneling,” on page 41.

d. Set up the data source. For instructions, see “Creating and Configuring a Data 
Source,” on page 41.

4. For portal installations, create and configure a WebLogic portal application. For 
instructions, see “Creating and Configuring a WebLogic Portal Application,” on 
page 59.

III. (Optional) Set Up the Web Server
If you plan to integrate WebLogic Server with either the Apache or IIS web server, follow 
instructions in Chapter 6, “Installing and Configuring the Web Server.”

IV. Install Content Server
You will install CS 7.0.3 by first installing and configuring CS 7.0.2 and then updating the 
installation to CS 7.0.3 by running the rollup installer. You will do the following:
1. Before running the CS 7.0.2 installer, make sure that:

- You have created the directory into which you are installing Content Server. The 
directory name and path cannot contain spaces and the application server must be 
able to read from and write to that directory.

- For clustered installations, you have created the following:
- A managed server. You will install Content Server on this server.
- A shared file system directory that all cluster members can read from and 

write to; the directory name and path cannot contain spaces. Note the 
following:
- For delivery systems, the default location of the shared file system 

directory is the directory containing the directory in which Content Server 
is installed.

- For content management and development systems, the default location 
of the shared file system directory is inside the directory in which Content 
Server is installed.

- You have added the JDK /bin directory to the path variable.
- Your system is capable of displaying the CS installer GUI. The installer will not 

work in text mode.
2. Install CS 7.0.2 by running the supplied installer. The installer provides online help at 

each screen, should you need guidance. For more information, see “Running the CS 
7.0.2 Installer,” on page 82. 
You will have to deploy the CS application halfway through the installation when the 
installer displays the “Installation Actions” window. For instructions, see one of the 
following sections:
Installing Content Server 7.0.3 with WebLogic Server
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- For web installations, see “Deploying Web Applications,” on page 46.
- For portal installations, see “Deploying Portal Applications,” on page 69.
If you are using an Oracle database and will require text attributes greater than 2000 
characters, you will have to set the cc.bigtext property to CLOB after the CS 
application is deployed. For instructions, see step 5 in “Running the CS 7.0.2 
Installer,” on page 82.

3. Install the CS 7.0.3 patch (“Running the CS 7.0.3 Rollup Installer,” on page 84).
You will deploy the CS application halfway through the installation, when the installer 
displays the “Installation Actions” window. For instructions, see one of the following 
sections:
- For web installations, see “Deploying Web Applications,” on page 46.
- For portal installations, see “Deploying Portal Applications,” on page 69.

4. Complete the post-installation steps that are appropriate for your system. Refer to 
“CS 7.0.3 Post-Installation Steps,” on page 84 for complete instructions.
a. If you installed Content Server on Unix, set the permissions for Content Server 

binaries by following the steps in “Setting File Permissions (Unix Only),” on 
page 84.

b. Verify the Content Server installation by logging in as the administrator into the 
Advanced and Dash interfaces. For instructions, see “Verifying the Content Server 
Web Installation,” on page 84. (On portal installations, the Portal interface does 
not yet exist; you will set it up in step e.)

c. If the CS system you installed is a delivery system, switch WebLogic to 
production mode. For instructions, see “Switching WebLogic to Production Mode 
(Delivery Systems Only),” on page 90.

d. If you need to perform LDAP integration, complete the steps in “Integrating with 
LDAP (Required for Portal Installations),” on page 91. LDAP integration is 
mandatory for portal installations and optional for web installations.

e. If you are creating a portal installation, use WebLogic Workshop to create a 
WebLogic portal, add pages to the portal, and populate the pages with the 
appropriate Content Server portlets. For instructions, see “Setting Up the Portal 
(Portal Installations Only),” on page 91.

5. If you are creating a vertically clustered system, follow instructions in “Setting Up a 
Content Server Cluster (Optional),” on page 97.

6. Once the entire installation is completed and verified, set up Content Server for its 
business purpose. For instructions, see the Content Server Administrator’s Guide and 
the Content Server Developer’s Guide. 
Installing Content Server 7.0.3 with WebLogic Server
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Par t  1

Database
This part contains a short chapter summarizing the databases that Content Server uses. 
Instructions on creating and configuring the databases are given in our guide Configuring 
Third-Party Software.

This part contains the following chapter:
• Chapter 2, “Setting Up a Database” 
Installing Content Server 7.0.3 with WebLogic Server
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Chapter 2

Setting Up a Database
Content Server requires access to a database that is specifically configured for Content 
Server. The list of supported databases (as well as other third-party components) is given 
in the Supported Platform Document (SPD) for each Content Server version. SPDs are 
available on the e-docs site at:

http://support.fatwire.com

(where you can obtain a password from FatWire Technical Support, if you do not already 
have a password.) 
Before installing any other of Content Server’s supporting software, you must complete 
the following steps:
1. Install the database management system. 

For instructions, refer to the product vendor’s documentation.
2. Create and configure a database for Content Server. 

For instructions, consult our guide Configuring Third-Party Software. Note that 
database configuration is identical across different application servers. Refer to the 
correct chapter to create and configure the database of your choice.
Installing Content Server 7.0.3 with WebLogic Server
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Chapter 3

Installing WebLogic Server
This chapter contains information about installing WebLogic Server to support and deploy 
your Content Server web or portal application.
This chapter contains the following sections:
• Start/Stop Commands
• Installing WebLogic Server
Installing Content Server 7.0.3 with WebLogic Server
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Start/Stop Commands
This section lists commands that are used in this guide for managing WebLogic Server.
• Start the admin server:

<domain_home>/startWebLogic.sh

• Stop the admin server: 
<domain_home>/bin/stopWebLogic.sh

• Start the node manager: 
<bea_home>/weblogic92/server/bin/startNodeManager.sh

• Start a managed server: 
<domain_home>/bin/startManagedWebLogic.sh <managed_server_name> 

http://<listening_address>:<admin_port>

• Stop a managed server: 
<domain_home>/bin/stopManagedWebLogic.sh <managed_server_name> 

http://<listening_address>:<admin_port>

• Start WebLogic Workshop:
<bea_home>/workshop92/workshop4WP/workshop4WP.sh
Installing Content Server 7.0.3 with WebLogic Server
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Installing WebLogic Server
1. Run the WebLogic Server installer (on Unix, make sure your DISPLAY variable is set).
2. At the “Welcome” screen, click Next. 

3. Click Yes to accept the BEA License Agreement.
Installing Content Server 7.0.3 with WebLogic Server



Chapter 3.  Installing WebLogic Server

 Installing WebLogic Server
18
4. Either use an existing BEA home directory or select Create a new BEA Home and 
browse for a directory. Click Next.  

Note

The BEA home directory will be referred to throughout this guide as 
<bea_home>. 
Installing Content Server 7.0.3 with WebLogic Server
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5. Select Custom Install Type and click Next. 
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6. In the “Choose Components” screen, do the following:
a. Make sure the following components are selected:

- Under WebLogic Server: 
- Server

- Server Examples

- Web Server Plugins (select this if you will be using a web server)
- Under Workshop for WebLogic Platform:

- Workshop

- Workshop Examples

- Under WebLogic Portal (portal installations only):
- Portal Server

- WebLogic Workshop Portal Extension

- Portal Examples

b. Click Next. 
Installing Content Server 7.0.3 with WebLogic Server
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7. Deselect Mercury profiling tools and click Next.
8. On the next three screens, click Next.
9. The installation starts. Close the window after completion. 

10. Do one of the following:

- If you are creating a web installation, continue with Chapter 4, “Configuring 
WebLogic Server for Web Installations” to configure a WebLogic domain.

- If you are creating a portal installation, continue with Chapter 5, “Configuring 
WebLogic Server for Portal Installations” to configure a WebLogic portal.

Note

If you installed WebLogic Server 9.2 MP, install the CR308102 public patch now.
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Par t  2

Application Server
This part contains information about installing and configuring WebLogic Server as well 
as integrating WebLogic Server with either the Apache or IIS web server.
This part contains the following chapter:
• Chapter 3, “Installing WebLogic Server” 
• Chapter 4, “Configuring WebLogic Server for Web Installations”
• Chapter 5, “Configuring WebLogic Server for Portal Installations”
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Chapter 4

Configuring WebLogic Server for Web 
Installations
This chapter contains information about configuring WebLogic Server to support and 
deploy your Content Server web application.
This chapter contains the following sections:
• Creating and Configuring a WebLogic Server Domain
• Setting Environment Variables
• (Optional) Disabling Host Name Verification
• Enabling HTTP Tunneling
• Creating and Configuring a Data Source
• Deploying Web Applications
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Creating and Configuring a WebLogic Server 
Domain

In the steps below, you will be creating a WebLogic domain and configuring the domain 
by adding an admin server. If you are creating a production system, you will also add a 
managed server to the domain, and if you are creating a cluster, you will add a managed 
server for each cluster member.

To create and configure a WebLogic Server domain 

1. Change directories to <bea_home>/weblogic92/common/bin and run 
config.sh (.bat for Windows).

2. Create a domain:
a. On the “Welcome” screen, select Create a new WebLogic domain and click 

Next. 
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b. Select Base this domain on an existing template and click Next. 
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c. Enter a domain user name and password and click Next. 
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d. Select Development Mode and the preferred SDK (in the “BEA Supplied JDKs” 
list box). For production environments, the domain will be changed to 
Production Mode later in this guide (step C on page 90). Click Next. 
Installing Content Server 7.0.3 with WebLogic Server



Chapter 4.  Configuring WebLogic Server for Web Installations

 Creating and Configuring a WebLogic Server Domain
30
e. In the “Customize Environment and Services Settings” screen, select Yes and 
click Next. 
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In the screens that follow, you will configure the domain by adding an admin server and 
managed servers as necessary. 
3. Configure the admin server:

a. Enter a name, listening address, and port for the admin server. 
b. Click Next. 

Note

Throughout this guide, the values that you entered will be referred to as 
<listening_address> and <admin_port>.
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4. Add a managed server:
a. Click Add and enter a name, listening address, and port. 

b. Click Next. 

Note

• For a production environment, a managed server is recommended.
• If you are creating a cluster, a managed server is required for each 

cluster member. Your options are to:
- Create all the managed servers in this step
- Create a managed server for the primary cluster member in this 

step, but postpone creating the remaining managed servers until 
CS is installed on the primary member. If you choose the latter 
option, you will need to follow instructions in “Setting Up a 
Content Server Cluster (Optional),” on page 97. 
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5. If you are not creating a cluster, click Next and skip to step 6 on page 35. Otherwise, 
create and configure a cluster: 
a. Create a cluster:

1) Click Add. 
2) Enter a name for the cluster. 
3) In the Multicast port field, enter the admin server listening port. 
4) Click Next.   
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b. Add the managed server(s) to the cluster (by clicking the managed server(s) and 
clicking the right arrow). Click Next. 
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6. Configure the node manager:
a. Click Add and enter a name and listening address. Click Next. 
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b. Add both the admin and managed servers to the node manager using the right 
arrow. Click Next. 

7. After reviewing the domain configuration, click Next. 
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8. Enter a name for the domain and the path where the domain will be created. Click 
Create. 

Note

The path to the domain will be referred to throughout this guide as 
<domain_home>.
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9. The domain installation begins. When the installation is complete, click Done. 

10. Your next steps are the following:
a. For all systems (production and otherwise), set the environment variables to 

ensure that all servers are using the correct JDK. For instructions, go to “Setting 
Environment Variables,” on page 39. 

b. For non-production environments, disable host name verification. For 
instructions, go to “(Optional) Disabling Host Name Verification,” on page 39. 

c. For all servers on which CS will be deployed, enable HTTP tunneling in order to 
support command-line deployment, using the weblogic.Deployer or 
weblogic.Admin utilities. For instructions, go to “Enabling HTTP Tunneling,” 
on page 41.
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Setting Environment Variables
Setting environment variables ensures that each server is using the right JDK.

To set environment variables 

1. Log into the Administration Console.
2. Expand Environment in the tree.
3. Click Servers.
4. Click ServerName.
5. Click the Configuration tab.
6. Click Server Start.
7. Click Lock & Edit.
8. For “Java Home,” enter the path to the WebLogic JDK (<bea_home>/jdk150_04).
9. For “Java Vendor,” enter Sun.
10. Click Save.
11. Click Accept Changes.
12. Repeat this procedure for each server in the system.
13. The next step is to disable host name verification for non-production environments. 

Follow instructions in the next section.

(Optional) Disabling Host Name Verification
For non-production environments, you may decide to disable host name verification.This 
section explains how to do so from both the command line and the administration console.

Command Line
For both the startWebLogic.sh and startManagedWebLogic.sh scripts (.bat in 
Windows) located in domain_home/bin, edit the script by inserting the following line 
after the first large comment block:

JAVA_OPTIONS="${JAVA_OPTIONS} -
Dweblogic.security.SSL.ignoreHostnameVerification=true"

Note

After host name verification is disabled: 
1. Enable HTTP tunneling in order to prepare the web application for command-

line controlled deployment. For instructions, see “Enabling HTTP Tunneling,” 
on page 41.

2. Create the data source. For instructions, see “Creating and Configuring a Data 
Source,” on page 41.
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Administration Console
1. Start the admin server.
2. Change to the <domain_home> directory and run startWebLogic.sh (.bat for 

Windows).
3. After the admin server has started, open a web browser and log in to the “WebLogic 

Server Administration Console” at:
http://<listening_address>:<admin_port>/console

4. In the tree at the left of the screen, expand Environment.
5. Click Servers.
6. For each of the servers listed:

a. Click the server name.
b. Click the Configuration tab.
c. Click SSL.
d. Click Advanced.

e. Click Lock & Edit in the upper left corner.
f. From the drop-down menu labeled Hostname Verification, select None.
g. Click Save.

7. Click Activate Changes. 
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Enabling HTTP Tunneling

In order to run commands using the weblogic.Deployer or weblogic.Admin 
utilities, HTTP tunneling must be enabled on each server. This section explains how to 
enable tunneling for any server that will be controlled from the command line.

To enable HTTP tunneling

1. Log in to the administration console.
2. Expand Environment on the left hand side.
3. Click Servers.
4. For the admin server and each managed server:

a. Click the server name.
b. Click the Protocols tab.
c. Click General.
d. Click Lock & Edit.
e. Click the Enable Tunneling check box.
f. Click Save.

5. Click Activate Changes.
6. The next step is to create a data source. Follow instructions in the next section.

Creating and Configuring a Data Source
This section explains how to create a data source for any of the supported databases using 
the WebLogic Server Administration Console. This section assumes the admin server has 
already been started. Two basic steps then need to be completed: 
A. Create the Data Source
B. Configure the Connection Pool Size

Note

The steps in this section must be completed before Content Server is deployed. 

Note

If you are using an Oracle database and require text attributes greater than 2000 
characters, you will have to set cc.bigtext to CLOB. To support CLOB, use 
Oracle database 9.2.0.6 (or a higher supported version). Also use Oracle 10g 
drivers. (CLOB is not supported for lower database versions and for Oracle drivers 
9x [thin, type 4].)
You will set cc.bigtext to CLOB when you run the Content Server installer (as 
explained in “Running the CS 7.0.2 Installer,” on page 82.)
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A. Create the Data Source
1. Log in to the WebLogic Server Administration Console.
2. In the tree at the left:

a. Expand Services.
b. Expand JDBC.
c. Click Data Sources.

3. Click New.
4. In the “Create a New JDBC Data Source” screen, enter the following values:

a. A name for the data source.
b. <datasource_name> for the JNDI name.
c. A database type/driver pair. The recommended choices are:

- MS SQL Server / BEA’s MS SQL Server Driver (Type 4)
- Oracle / Oracle’s Driver (Thin)
- DB2 / BEA’s DB2 Driver (Type 4)

 

5. Click Next.
6. Click Next in the screen that follows.
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7. For “Connection Properties,” enter the database name, host name for the database 
server, port, user name, and password. Click Next. 
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8. Verify that the data source information is correct, and click Test Configuration. This 
will test your data source. If the test fails, review your data source information, and try 
again. When the test succeeds, click Next. 
Installing Content Server 7.0.3 with WebLogic Server



Chapter 4.  Configuring WebLogic Server for Web Installations

 Creating and Configuring a Data Source
45
9. Check both the admin and managed servers and click Finish. 

10. Click Activate Changes.

B. Configure the Connection Pool Size
The default values allow a connection pool to contain only up to 15 physical connections. 
This value needs to be increased. 
1. In the left-hand tree: 

a. Expand Services.
b. Expand JDBC.
c. Click Data Sources.

2. Click on the newly created data source.
3. In the Configuration tab click Connection Pool.
4. Click Lock & Edit.
5. For “Initial Capacity,” enter 10 and for “Maximum Capacity,” enter 100.
6. Click Save.
7. Click Accept Changes.
8. Your next step is one of the following:

- If you wish to integrate with the Apache or IIS web server, follow instructions in 
Chapter 6, “Installing and Configuring the Web Server.”

- To install Content Server, follow instructions in Chapter 7, “Installing and 
Configuring Content Server.”
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Deploying Web Applications
This section shows you how to deploy a web application on WebLogic Server using the 
weblogic.Deployer utility. You will refer to the steps below halfway through the 
Content Server installation (Chapter 7).

A. Set Up the Environment for weblogic.Deployer

1. Set the JAVA_HOME environment variable to the WebLogic JDK located in 
<bea_home>. 

2. Finish setting up the environment by sourcing the setWLSEnv.sh/cmd script found 
in <bea_home>/weblogic92/server/bin. This is done on Unix with
. setWLSEnv.sh or source setWLSEnv.sh.   

B. Deploy the Web Application
1. Start the admin server.
2. If you are deploying in a production environment, start the node manager and the 

managed server.
3. Deploy the web application.

Note 

The weblogic.Deployer command set requires its environment to be 
configured. This environment must not be used for installing Content Server. 

Note 

The deployment name takes the name of the directory that the application 
was deployed to, or the name that the application was given during the 
Content Server installation:
java weblogic.Deployer -adminurl http://

<listening_address>:<admin_port> -user <domain_login> 
-password <domain_password> -name <deployment_name> -
targets AdminServer -nostage -deploy 
<deployment_dir>/<deployment_name>

Example of deployment_dir:
/u01/software/Apps/Weblogic/user_projects/domains/
csDomain/applications 

Example of deployment_name:
ContentServer
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4. When the application has been deployed, it will start automatically. You can stop, 
start, or undeploy the application with the following commands:
- Stop the application: 

java weblogic.Deployer -adminurl http://
<listening_address>:<admin_port> -user <domain_login> -
password <domain_password> -name <deployment_name> -stop

- Start the application: 
java weblogic.Deployer -adminurl http://

<listening_address>:<admin_port> -user <domain_login> -
password <domain_password> -start -name <deployment_name>

- Undeploy the application: 
java weblogic.Deployer -adminurl http://

<listening_address>:<admin_port> -user <domain_login> -
password <domain_password> -name <deployment_name> -
undeploy
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Chapter 5

Configuring WebLogic Server for Portal 
Installations
This chapter contains information about configuring WebLogic Server to support and 
deploy your Content Server portal application.
This chapter contains the following sections:
• Creating and Configuring a WebLogic Portal Domain
• Creating and Configuring a Data Source
• Creating and Configuring a WebLogic Portal Application
• Deploying Portal Applications
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Creating and Configuring a WebLogic Portal 
Domain

In the steps below, you will be creating and configuring a WebLogic Portal domain and the 
admin server that is created in the process.

To create and configure a WebLogic portal domain

1. Run the WebLogic Configuration Wizard by executing the following command:
<bea_home>/wlserver_10.0/common/bin/config.sh

2. In the “Welcome” screen, select Create a New WebLogic Domain. Click Next.
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3. In the “Select Domain Source” screen, do the following: 
a. Select Generate a domain configured automatically to support the following 

BEA products.
b. Select the WebLogic Portal check box.
c. Click Next.

4. Enter a user name and password for the administrator of the portal domain. Click 
Next.
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5. In the “Configure Server Start Mode and JDK” screen, do the following:
a. In the “Startup Mode” area, select Development Mode. For production 

environments, the domain will be changed to Production Mode later in this guide 
(step C on page 90).

b. In the “JDK Selection” area, select BEA Supplied JDKs and select JRockit SDK 
from the list.
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6. In the “Customize Environment and Services Settings” screen, select No. Click Next.

7. Enter a name for the domain, and the path where the domain will be created. (This 
path will be referred to throughout this guide as <domain_home>.) Click Create. 

8. When the creation process is complete, click Done.
Installing Content Server 7.0.3 with WebLogic Server



Chapter 5.  Configuring WebLogic Server for Portal Installations

 Creating and Configuring a WebLogic Portal Domain
54
9. Edit the file <domain_home>/bin/setDomainEnv.sh by making the following 
changes:
a. Find the following statement:

if [ "${debugFlag}" = "true" ]

b. Add the following code to the JAVA_OPTIONS line below the if statement:
-da:oracle.adf... -da:oracle.adfinternal... 

-da:oracle.adfdemo... -da:oracle.uix...

The modified JAVA_OPTIONS line will look as follows:
JAVA_OPTIONS="${JAVA_OPTIONS} ${enableHotswapFlag} -ea 

-da:oracle.adf... -da:oracle.adfinternal... -
da:oracle.adfdemo... -da:oracle.uix... -da:com.bea... 
-da:javelin... -da:weblogic... -ea:com.bea.wli... 
-ea:com.bea.broker... -ea:com.bea.sbconsole..."

10. Start the admin server.
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Creating and Configuring a Data Source
This section explains how to create a data source for any of the supported databases using 
the WebLogic Server Administration Console. This section assumes the admin server has 
already been started. Two basic steps then need to be completed: 
A. Create the Data Source
B. Configure the Connection Pool Size

A. Create the Data Source
1. Log in to the WebLogic Server Administration Console.
2. In the tree at the left:

a. Expand Services.
b. Expand JDBC.
c. Click Data Sources.

3. Click New.
4. In the “Create a New JDBC Data Source” screen, enter the following values:

a. A name for the data source.
b. <datasource_name> for the JNDI name.
c. A database type/driver pair. The recommended choices are:

- MS SQL Server / BEA’s MS SQL Server Driver (Type 4)
- Oracle / Oracle’s Driver (Thin)
- DB2 / BEA’s DB2 Driver (Type 4)
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5. Click Next.
6. Click Next in the screen that follows.
7. For “Connection Properties,” enter the database name, host name for the database 

server, port, user name, and password. Click Next. 
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8. Verify that the data source information is correct, and click Test Configuration. This 
will test your data source. If the test fails, review your data source information, again. 
When the test succeeds, click Next. 
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9. Check both the admin and managed servers and click Finish. 

10. Click Activate Changes.

B. Configure the Connection Pool Size
The default values allow a connection pool to contain only up to 15 physical connections. 
This value needs to be increased. 
1. In the left-hand tree: 

a. Expand Services.
b. Expand JDBC.
c. Click Data Sources.

2. Click on the newly created data source.
3. In the Configuration tab click Connection Pool.
4. Click Lock & Edit.
5. For “Initial Capacity,” enter 10 and for “Maximum Capacity,” enter 100.
6. Click Save.
7. Click Accept Changes.
8. Continue on to the next section, “Creating and Configuring a WebLogic Portal 

Application,” on page 59.
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Creating and Configuring a WebLogic Portal 
Application

This section shows you how to create a portal application using WebLogic Workshop.
1. Stop the admin server.
2. Start WebLogic Workshop by executing the following command:

<bea_home>/workshop_10.0/workshop4WP/workshop4WP.sh

3. (Optional) If you have not yet specified a workspace directory, you will be prompted 
to do so. Set the directory, then click OK.

4. Create a Portal EAR project. Do the following:
a. In the File menu, select New, then Project.
b. In the “Select a Wizard” screen, expand WebLogic Portal and select Portal EAR 

Project. Click Next.
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c. Enter a name for the new project. Click Finish.
d. In the pop-up window that appears, click Yes.

5. Define a new WebLogic server:
a. Switch to the “Workshop” view. From the Window menu, select Open 

Perspective, then Workshop.
b. In the File menu, select New, then Server.
c. In the “Define a New Server” screen, expand BEA Systems, Inc. and select BEA 

WebLogic v10.0 Server. Click Next.
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d. In the “Define a WebLogic Server” screen, click Browse.

e. Browse to the <domain_home> directory you specified in step 7 on page 53. 
Click OK.

f. In the “Define a WebLogic Server” screen, click Next.
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g. In the left-hand list, select the Portal EAR project you created in step 4 on page 59 
and click Add. Then click Finish.

6. Create a Portal Web project. Do the following:
a. Switch to the “Portal” view. In the Window menu, select Open Perspective, then 

Portal.
b. In the File menu, select New, then Portal Web Project.
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c. In the “Select a Wizard” screen, expand WebLogic Portal and select Portal Web 
Project. Click Next.

d. Enter a name for the new project, and select the Add project to an EAR check 
box. Click Next.
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e. In the “Select Project Facets” screen, click Next.

f. In the “Web Module” screen, do the following:
1) Enter a supported context root (cs or servlet).
2) Enter a content directory name. (This directory will be referred to later in this 

guide as <content_dir>.)
3) In the Java Source Directory field, enter src.
4) Click Finish.
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g. Wait until the Portal Web project is created and configured, then click Done.

7. Create a Datasync project:
a. In the File menu, select New, then Datasync Project.
b. In the “Select a Wizard” screen, expand WebLogic Portal and select Datasync 

Project, then click Next.
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c. In the Project name field, enter a name for the new project and click Next.

d. Select the Portal EAR project created in step 4 on page 59 and click Finish.

8. Return to WebLogic Workshop and check the status of the Portal EAR project. If 
errors are displayed, right-click the Portal EAR project in the Package Explorer pane 
and select Refresh.
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9. Disable validation of JSP syntax, XML, and XML schema. Do the following:
a. In the Package Explorer pane on the left, right-click the Portal Web project and 

select Properties.
b. In the left pane, click Validation.
c. Deselect the JSP Syntax Validator, XML Validator, and XML Schema 

Validator check boxes.
d. Click OK.

10. Synchronize the newly defined WebLogic server:
a. Start the admin server using the following command (do not use Workshop to start 

the server):
<domain_home>/startWebLogic.sh
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b. Once the admin server starts, the status of the WebLogic server you created 
changes to “Started”:

c. Right-click the WebLogic server and select Publish.
When publishing completes successfully, the state of the WebLogic server 
changes to “Synchronized.”

11. Your next step is one of the following:
- If you wish to integrate with the Apache or IIS web server, follow instructions in 

Chapter 6, “Installing and Configuring the Web Server.”
- To install Content Server, follow instructions in Chapter 7, “Installing and 

Configuring Content Server.”
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Deploying Portal Applications
This section shows you how to deploy portal applications using WebLogic Workshop. You 
will perform the steps below half-way through the Content Server installation.

1. Start WebLogic Workshop by executing the following command:
<bea_home>/workshop_10.0/workshop4WP/workshop4WP.sh

2. Start the admin server using the following command (do not start it using Workshop):
<domain_home>/startWebLogic.sh

When the admin server starts successfully, the status of the WebLogic server changes 
to “Started.”

3. Build (or rebuild) the portal application. In the Package Explorer pane on the left, 
right-click the portal application and select Refresh. When the application completes 
building, the status of the WebLogic server changes to “Republish.” This means that 
the most recent version of the portal application has not yet been deployed to the 
server.

Note

Before deploying the CS Portal application, you must do the following:
1. Edit the file,

<content_dir>/WEB-INF/classes/commons-logging.properties 
and add priority=1 directly under the date.

2. Move the file,
<content_dir>/WEB-INF/lib/commons-logging-1.1.jar
to <domain_home>/lib.
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4. Right-click the WebLogic server and select Publish.

When the state of the WebLogic server changes to “Synchronized,” the portal 
application has been successfully deployed.
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Web Server
This part shows you how to install and configure the Apache and IIS web servers. Both are 
optional components in a Content Server installation. 
This part contains the following chapter:
• Chapter 6, “Installing and Configuring the Web Server” 
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Chapter 6

Installing and Configuring the Web Server 
This chapter provides guidelines for integrating WebLogic Server with your choice of 
either the Apache web server or the IIS web server. Note that integrating with a web server 
is optional.
This chapter contains the following sections:
• Installing and Configuring Apache 2.0.x Plug-in
• Installing and Configuring IIS Plug-in for IIS 6.0 and Higher
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Installing and Configuring Apache 2.0.x Plug-in
This section explains how to integrate Apache 2.0.x with WebLogic Server using the 
mod_wl_20.so plug-in.

To install Apache

1. Install Apache 2.0.x HTTP server.
2. Make sure that mod_so.c is enabled. Run <apache_home>/bin/apachectl –l. 

If mod_so.c is not in the list that is printed, you must rebuild your Apache with the
–enable-module=so option.

3. Copy the mod_wl_20.so file from <bea_home>/weblogic92/server/plugin/
<os_type>/<os_version> to <apache_home>/modules. On Linux, it is located 
in the <bea_home>/weblogic92/server/plugin/linux/i686 directory.

4. Edit the http.conf file which is located in the <apache_home>/conf directory. 
a. Add the following to the LoadModules section:

LoadModule weblogic_module modules/mod_wl_20.so

b. Before “Section 3” of the httpd.conf file, add the following lines: 
- For a non-clustered environment:

<IfModule mod_weblogic.c>
  WebLogicHost <listening_address>
  WebLogicPort <listen_port>
</IfModule>

- For a clustered environment:
<IfModule mod_weblogic.c>
  WebLogicCluster <listening_address1>:<listen_port1>,

<listening_address2>:<listen_port2>
</IfModule>

c. After the last Location tag, add the following:
<Location /servlet>
SetHandler weblogic-handler
</Location>

5. Verify the syntax of the <Apache_home>/conf/httpd.conf file with the 
following command: 
<Apache_home>/bin/apachectl -t

6. You are now ready to install Content Server. For instructions, go to Chapter 7, 
“Installing and Configuring Content Server.” 
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Installing and Configuring IIS Plug-in for IIS 6.0 
and Higher

You configure IIS for WebLogic by mapping two file extensions to the WebLogic 
application. Mapping the file extensions takes two steps: 
A. Use the IIS console to map the .jsp and .wlforward extensions to the appropriate 

.dll provided by WebLogic.
B. Create a configuration file called iisproxy.ini, which specifies how to contact 

WebLogic. Creating the configuration file is a manual step that you complete outside 
the IIS console.

A. Create the Application Mappings and the ISAPI Filter
Complete the following steps:
1. Right-click the My Computer icon on your desktop and select Manage from the 

pop-up menu.
2. In the “Computer Management” window, select Services and Applications > 

Internet Information Services.
3. Right-click Default Web Site and select Properties. 
4. In the Default Web Site Properties dialog box, select the Home Directory tab. 
5. Click in the Execute Permissions field and select Scripts and Executables from the 

drop-down list.
6. Click Configuration.
7. In the Application Configuration dialog box, select the App Mappings tab. 
8. In the App Mappings dialog box, verify that the Cache ISAPI applications option is 

selected. 
9. Click Add. 
10. In the Add/Edit Application Extension Mapping form, create a mapping for the 

.jsp file extension. Enter the following values: 

11. Click OK. 
12. Back in the App Mappings dialog box, click Add again.

Field Set to This Value

Executable Click Browse. Navigate to and select: 
<bea_home>\weblogic92\server\native\win\
  <os_version>iisproxy.dll

Extension jsp (not .jsp — do not include the period)

Verbs All verbs (the default)

Script engine Clear this option.

Check that file exists Clear this option.
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13. This time in the Add/Edit Application Extension Mapping dialog box, create a 
mapping for the .wlforward file extension. Enter the following values: 

14. Click OK.
15. Back in the App Mappings dialog box, click Apply; then click OK.

In the Application Configuration window you see two new Application Mapping 
entries named .jsp and .wlforward. 

16. Click OK.
17. In the Default Web Site Properties dialog box, select the ISAPI Filters tab.
18.  Click Add… 
19. In the Filter Properties form, create a filter that uses the WebLogic 

iisforward.dll file. Enter the following values:

20. Click OK. 
21. In the Default Web Site Properties dialog box, click Apply; then click OK. 
22. The installed version of IIS with its initial settings does not allow the iisproxy.dll. 

Use the IIS Manager console to enable the Plug-In: 
a. Open the IIS Manager console. 
b. Select Web Service Extensions. 
c. Set “All Unknown ISAPI Extensions” to Allowed. 

Item Set It to This Value

Executable Click Browse. 
Navigate to and select: 
<bea_home>\weblogic92\server\native\win\
  <os_version>iisproxy.dll

Note: Be sure to select iisproxy.dll; do not select 
iisforward.dll

Extension wlforward (not .wlforward — do not include the period)

Verbs All verbs (the default)

Script engine Clear this option.

Check that file exists Clear this option.

Item Set It to This Value

Filter Name You can specify an arbitrary name, but we recommend:
 iisforwardfilter 

Executable Click Browse. Navigate to and select: 
<bea_home>\weblogic92\server\native\win\
  <os_version>iisproxy.dll 
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B. Create the iisproxy.ini Configuration File
1. Open a text editor and create a new file.
2. In this file, enter the following statements. Be aware that the case of each property 

must exactly match the case specified here:
WebLogicHost=<listening_address>
WebLogicPort=<managed_listen_port> 
ConnectTimeoutSecs=20
ConnectRetrySecs=5
WlForwardPath=/servlet

3. Save and name the file: iisproxy.ini 
4. Place the file in the following directory:

<bea_home>\weblogic92\server\bin 

5. Restart all the IIS services. If you need instructions, follow the steps below. 

a. Right-click the My Computer icon.
b. Select Manage from the pop-up menu.
c. In the Computer Management dialog box, expand the Services and 

Applications node in the tree.
d. Select Services.
e. In the list of services on the right, right click IIS Admin Service.
f. Select Start from the pop-up menu.

To start (or stop) the default web site only

a. Right-click the MyComputer icon. 
b. Select Manage from the pop-up menu.
c. In the Computer Management window, expand the Services and Applications. 

node in the tree.
d. Expand the Internet Information Services node.
e. Right-click Default Web Site.
f. Select Start (or Stop, as appropriate), from the pop-up menu.

6. You are now ready to install Content Server. For instructions, got to Chapter 7, 
“Installing and Configuring Content Server.” 

Note 

In the WlForwardPath property, /servlet corresponds to 
<WebRoot> in the installer screens for WebLogic (/servlet is normally 
the application server context).

Note

You can start the various IIS services in various ways. To be sure that all the 
necessary services are running, start IIS from the Services node.
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Par t  4

Content Server
This part shows you how to install Content Server. It contains the following chapter:
• Chapter 7, “Installing and Configuring Content Server”
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Chapter 7

Installing and Configuring Content Server
This chapter provides guidelines for installing Content Server on WebLogic Server, 
connecting to the supported database of your choice. 
This chapter contains the following sections:
• Installing CS 7.0.2
• Running the CS 7.0.3 Rollup Installer
• CS 7.0.3 Post-Installation Steps
• Setting Up a Content Server Cluster (Optional)
• Setting Up Content Server for Its Business Purpose
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Installing CS 7.0.2
After completing Steps I – IV.1 in the “Installation Quick Reference,” on page 7, you 
install Content Server 7.0.2 using the provided installer. The installation process consists 
of two stages:
• In the first stage, the installer gathers necessary configuration information and installs 

the file structure. At the end of the first stage, the installer displays an “Installation 
Actions” window prompting you to deploy the CS application. Follow instructions in 
“Deploying Web Applications,” on page 46 or “Deploying Portal Applications,” on 
page 69.
If you are using an Oracle database and require text attributes greater than 2000 
characters, you must set the cc.bigtext property to CLOB after the CS application is 
deployed. (For instructions, see step 5 in the next section.)
If the first stage fails, the installer allows you to go back and modify your 
configuration options (except the database type), and retry the installation.

• In the second stage, the installer populates the database with the tables and data 
required for Content Server to function. If the second stage fails, the file structure and 
database tables must be deleted and the installation restarted from the beginning.

Running the CS 7.0.2 Installer
1. Make sure you have completed Steps I – IV.1 in the “Installation Quick Reference,” 

on page 7.
2. Extract the Content Server installer archive into a temporary directory.
3. Change to the temporary directory containing the installer files.
4. Execute the installer script:

- On Windows: csInstall.bat
- On Unix: csInstall.sh
The installer provides online help at each screen. Read the online help for detailed 
explanations of the options that are presented in each screen. If you encounter 
problems during the installation process, consult the online help for possible causes 
and solutions.

Note

If you need to change the type of database you have specified during the 
installation, you must delete the installed CS file structure and restart the 
installation.
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5. If you are using an Oracle database and require text attributes greater than 2000 
characters, you must set the cc.bigtext property to CLOB. When the installer 
displays the “Installation Actions” pop-up window, complete step 1 displayed in the 
window, then do the following:
a. Open the Property Editor by clicking the Property Editor button.
b. In the Property Editor, open the futuretense.ini file.
c. Click the Database tab.
d. Locate the cc.bigtext property and set its value to CLOB.
e. Save your changes and close the Property Editor.
f. Continue on to step 3 displayed in the “Installation Actions” window.

6. When the installation completes successfully, continue with the next step, “Running 
the CS 7.0.3 Rollup Installer.”

Note

Deployment. The installer requires the war file to be deployed manually as an unpacked file. 
To ensure correct deployment, do the following:
• When entering deployment information, you must select the following check box:

This application will be deployed manually. 

• When deploying the CS application in WebLogic, point to the unpacked CS web 
application (by using either the weblogic.Deployer utility or the WebLogic console).

Select this checkbox. 
This option has the 
installer create the 
war file and 
automatically unpack 
it into the directory 
that you will specify in 
the next dialog.
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Running the CS 7.0.3 Rollup Installer
After you have successfully installed CS 7.0.2:
1. Run the CS 7.0.3 rollup installer to update your CS installation to version 7.0.3.
2. When the “Installation Actions” window prompts you to deploy the CS application, 

complete the steps in one of the following sections:
- For web installations, see “Deploying Web Applications,” on page 46.
- For portal installations, see “Deploying Portal Applications,” on page 69.

CS 7.0.3 Post-Installation Steps
When the CS 7.0.3 installation completes successfully, perform the following steps:

A. Setting File Permissions (Unix Only)
B. Verifying the Content Server Web Installation
C. Switching WebLogic to Production Mode (Delivery Systems Only)
D. Integrating with LDAP (Required for Portal Installations)
E. Setting Up the Portal (Portal Installations Only)

A. Setting File Permissions (Unix Only)
If you installed Content Server on Unix, you must grant the “executable” permission to all 
files in the <cs_install_dir>/bin directory. To do so, perform the following steps:
1. Change to the <cs_install_dir>/bin directory.
2. Run the following command: chmod +x *
3. Restart the corresponding WebLogic server.

B. Verifying the Content Server Web Installation
In this section, you will log in to Content Server’s Advanced and Dash interfaces in order 
to verify that Content Server functions. 

Logging in to the Advanced Interface
1. Point your browser to the following URL: 

http://<hostname>:<port>/<context>/Xcelerate/LoginPage.html

Note

On portal installations, do not try to log in to the Portal interface at this point as it 
does not yet exist until you complete the steps in “Setting Up the Portal (Portal 
Installations Only),” on page 91.
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Content Server displays the Advanced interface login form.

2. Enter the following credentials:
- User name: fwadmin 
- Password: xceladmin

3. Click Login.
Depending on whether you installed sample sites, one of the following happens:
- If you did not install any sample sites, you are logged in to the built in Content 

Server management site. Only system administration functionality is available.
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- If you installed one sample site, you are logged in to that site.

- If you installed more than one sample site, Content Server displays the “Select 
Site” screen. In such case, select the sample site you wish to log in to.
Installing Content Server 7.0.3 with WebLogic Server



Chapter 7.  Installing and Configuring Content Server

 CS 7.0.3 Post-Installation Steps
87
When you select a site, you are logged in to that site.

Logging in to the Dash Interface
1. Point your browser to the following URL: 

http://<hostname>:<port>/<context>

Content Server displays the Dash interface login page.

2. Enter the following credentials:
- User name: fwadmin 
- Password: xceladmin
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3. Click Login.
Depending on whether you installed sample sites, one of the following happens:
- If you did not install any sample sites, Content Server displays a message 

notifying you of that fact. You will not be able to log in to the Dash interface until 
at least one site exists on your system.

- If you installed one sample site, you are logged in to that site.

- If you installed more than one sample site, Content Server displays the “Select 
Site” screen. In such case, select the sample site you wish to log in to.
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When you select a site, you are logged in to that site.
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C. Switching WebLogic to Production Mode (Delivery Systems 
Only)

If you created a delivery system, switch WebLogic to production mode:
1. Log in to the WebLogic Administration Console.
2. Click the domain name in the tree.
3. Click the General tab.
4. Click Lock & Edit.
5. Select the check box next to Production Mode.
6. Click Save.
7. Click Accept Changes.
8. Restart all servers.

9. After restarting all servers you may see the following error:
<BEA-090782><Server is Running in Production Mode and Native 
Library(terminalio) to read the password securely from 
commandline is not found.>

If you receive this error, do the following:
a. Modify your WebLogic start scripts. The scripts are:
- <domain_home>/bin/startWebLogic.sh

- <domain_name>/bin/startManagedWebLogic.sh

(If using Windows, the files will have .bat extensions instead of .sh.)
Add the following (as a single line) to each script:
JAVA_OPTIONS="${JAVA_OPTIONS}

 -Dweblogic.manangement.allowPasswordEcho=true"

b. Restart all servers.

Note

If you need to turn off production mode, set the environment for 
weblogic.deployer as shown in the previous section “Set Up the Environment 
for weblogic.Deployer,” on page 46 (assuming you open a new window), then run 
the following command: 
java weblogic.Admin -url :<admin_listen_port>/" href="http:/

/:<admin_listen_port>"http://
<listening_address>:<admin_listen_port> 
-username weblogic -password demo4132 SET -type Domain 
-property ProductionModeEnabled false
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D. Integrating with LDAP (Required for Portal Installations)
LDAP integration is mandatory for portal installations, and optional for web installations. 

If you need to perform LDAP integration, you must do the following:
1. Set up a supported LDAP server of your choice. For instructions, see Configuring 

Third-Party Software.
2. Run the LDAP integration program included on the Content Server CD.
For more information, see the LDAP Integration Guide.

E. Setting Up the Portal (Portal Installations Only)
For portal installations, you must create and populate a WebLogic portal using WebLogic 
Workshop.

Creating the Portal
1. Start WebLogic Workshop by executing the following command:

<bea_home>/workshop_10.0/workshop4WP/workshop4WP.sh

2. In the File menu, select New, then Portal.
3. In the “New Portal” screen, expand the Portal Web project you created for your portal 

and select the content directory, <content_dir>, which you specified in step f on 
page 64 when you created the project.

4. In the File name: field, enter a file name for the project. The file name must either 
have a .portal extension, or no extension at all.

5. Click Finish and proceed to the next section to populate the portal with pages and 
Content Server portlets.

Populating the Portal
1. Copy the login portlet files to the web application. Do the following:

a. Go to the Misc/BEA_Portal directory inside the temporary directory into which 
you decompressed the CS installer archive.

b. Copy the Login.portlet file to the <content_dir> directory of the 
WebLogic Workshop Portal project you created in the previous section.

Note

If you need to perform LDAP integration, you must do so before installing the
CS 7.0.3 patch.

Note

In this section you will create and populate your portal. However, the Portal 
interface will not function until you update your CS installation to version 7.0.3 as 
explained later in this chapter.
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c. (Optional) If you installed Spark sample portlets, do the following:
1) Copy SparkSample/login.jsp to <content_dir>/SparkSample
2) Copy WEB-INF/lib/bealoginportlet.jar to 

<content_dir>/WEB-INF/lib

2. Publish the changes to the affected WebLogic server.
3. In the Package Explorer pane at the left, expand the Portal Web project you created 

in “Creating and Configuring a WebLogic Portal Application,” on page 59, then 
expand the content directory, <content_dir>, which you specified in step f on 
page 64. 

4. Add pages to the portal. (You will name them in the next step.) Do the following:
a. In the Outline pane in the lower left, expand Desktop.
b. Right-click Book:Main Page Book. select Insert, and click New Page. Repeat 

this step for each page listed in the following table:

Table 2: Portlets and their functions

Name Purpose

Portal Login Allows users to log in to the portal. Used by all systems 
(development, content management, and delivery).

CS Content Displays portlets used to manage structured content. Create 
this page on development and content management systems, 
but not on delivery systems.
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When you are finished, the pages will appear in the center pane, as follows:

CS Documents Displays portlets used to manage document-based content. 
Create this page on development and content management 
systems, but not on delivery systems.

Spark Display 
(optional)

Create this page if you installed the Spark sample site and 
want to display its content in the portal.

Admin (optional) Create this page if you installed the Spark sample site and 
wish to use its administrative portlets to manage the users 
working in the Spark sample site on your development and 
content management systems.
You can not use the Spark administrative portlets to manage 
users working in sites other than the Spark sample site; in 
such cases, do not create this page.

Table 2: Portlets and their functions (continued)

Name Purpose
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5. Name the pages you created in step 4. Do the following for each page:
a. Select the tab belonging to the page you want to name.
b. Enter a name for the page in the Title field in the Properties pane at the right.
c. If the Properties pane does not display the properties of the page you selected, 

double-click the page in the Outline pane in the lower left.
When you are finished, the names you assigned to the pages will be displayed in the 
corresponding tabs in the center pane, as follows:

6. (Optional) If you want to change the layout of a page (the default is a two-column 
layout), do the following:
a. In the Outline pane in the lower left, double-click the page whose layout you 

want to change.
b. In the Properties pane at the top right, expand Page Properties.
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c. In the Layout Type field, select the desired layout.

d. Select another property within the Properties pane to apply the new layout to the 
page.

7. Populate each page with the appropriate CS portlets, according to the table below.
Do the following:
a. Select the tab corresponding to the page you want to populate.
b. Drag the portlets from the Palette pane in the lower right to the corresponding 

page, as described in the following table (the portlets are displayed under 
Available Portlets):

Page Portlets to Add to Page

Portal Login Login

CS Content SiteInfo, ActiveContent, CheckedoutContent, 
ContentAssignments, SearchContent, CreateContent, 
ContentHistory

CS Documents SiteInfo, ActiveDocuments, CheckedoutDocuments, 
DocumentAssignments, SearchDocuments, 
DocumentHistory, MyDocuments

Spark Display
(if created)

SiteInfo, SparkAds, SparkDocuments, SparkJobs, 
SparkNews

Admin (if created) RolesAdmin, ClearCheckouts, ContentDefinition, 
ClearAssignments, PublishTarget
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For example, when you are finished populating the “CS Content” page, it will 
look similar to the following:

8. Save your changes. In the File menu, click Save.
9. Publish the changes to the WebLogic server. Do the following:

a. Rebuild the portal application to include your changes. In the Package Explorer 
pane in the upper left, navigate to the Portal Web project you created for your 
portal, right-click on the project, and select Refresh.
When the application is successfully rebuilt, the status of the WebLogic server 
changes to “Republish.” This means that the most recent version of the portal 
application has not yet been deployed to the server.

b. Redeploy the portal application. Right-click the WebLogic server and select 
Publish.
When the state of the WebLogic server changes to “Synchronized,” the portal 
application has been successfully redeployed to include your changes.

10. Continue to “Verifying Your Portal Installation,” on page 97.
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Verifying Your Portal Installation
Once CS 7.0.3 has been installed and the portal has been configured, test your installation 
as follows:
1. Log in to the Portal interface:

a. Point your browser to the following URL:
http://<hostname>:<port>/<context>/<portal_app_name>.portal

The portal login form appears:

b. Enter the following credentials:
- Username: fwadmin

- Password: xceladmin

c. Click Login.
2. Select each tab in the tab bar and check whether the portlets you configured in 

“Setting Up the Portal (Portal Installations Only),” on page 91 are displayed.

Setting Up a Content Server Cluster (Optional)
If you plan to install a vertical cluster, complete the following steps:

A. Adding a Managed Server
B. Creating Additional Cluster Members
C. Creating and Configuring a Cluster

Before starting the steps in this section, make sure of the following:
• You have a full Content Server installation on a managed server.
• You are installing a vertical cluster (WebLogic managed servers are installed on the 

same machine).

A. Adding a Managed Server
If you do not have a managed server in addition to the managed server that was used in the 
previous section, you must create one for each of the remaining cluster members. 
Otherwise, skip to the next step, “B. Creating Additional Cluster Members.”

To add a managed server

1. Log into the “WebLogic Administration Console.”
2. Expand Environment.
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3. Click Servers.

4. Click Lock & Edit.

5. Click New.

6. Enter a name for the new managed server. Enter the listening address, which is the 
same as the admin server. Enter the listening port, a port different from the admin 
server and other managed servers. Select No, this is a stand-alone server, and click 
Next.

7. Click Finish.

8. Click Accept Changes.

9. Click Servers.
10. Click on the managed server you just created.
11. On the Configuration tab, click General.
12. Click Lock & Edit.
13. From the Machine drop-down menu, select the node manager that was created during 

the domain configuration.
14. Click Save.
15. Click Activate Changes.
16. Start the new managed server.
17. Repeat this procedure for each additional managed server. 

B. Creating Additional Cluster Members
1. After adding the managed server(s), create the cluster members by repeating the steps 

in the following sections for each member: 
a. “Installing CS 7.0.2,” on page 82
b. “Running the CS 7.0.3 Rollup Installer,” on page 84
c. “CS 7.0.3 Post-Installation Steps,” on page 84
When this has been done, you should have at least a primary cluster member and a 
secondary cluster member. 

2. The managed servers now need to be placed in a cluster. For instructions, continue 
with the next section.

C. Creating and Configuring a Cluster
If you did not create and configure a cluster when creating the domain, you will need to do 
so now. In this section, you will place the managed servers (hosting Content Server) into 
the cluster. 

To create and configure a cluster

1. Create a cluster:
a. Log in to the administration console.
b. Expand Environment.
c. Click Clusters.
d. Click Lock & Edit.
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e. Click New.
f. Enter a name for the cluster. Leave the default multicast address. Enter the Admin 

Port for Multicast port. Click OK.
g. Click Activate Changes.

2. Add servers to the cluster:
a. While logged in to the administration console, click Servers. 
b. For each managed server that will be a cluster member:

1) Click on the server name.
2) Click Lock & Edit.
3) On the Configuration tab, select the cluster created previously in this section 

for the Cluster drop-down menu.
4) Click Save.
5) Click Activate Changes.

3. Configure file locking and cluster parameters:
a. Stop the applications running on the cluster members.
b. Create a sync directory under <shared_dir>.
c. For each application on a cluster member:

Edit the <cs_install_dir>/futuretense.ini file. Set ft.sync to a value 
that is the same for all cluster members. Set ft.usedisksync to the path of the 
created sync directory.

4. Copy all the files from <cs_install_dir>/bin to <bea_home>/weblogic92/
server/native/<os_type>/<os_version>. 

5. For example, on Linux, copy the files to: <bea_home>/weblogic92/server/
native/linux/i686/

6. Start the applications on the cluster members. For login information, see “Verifying 
the Content Server Web Installation,” on page 84.

7. Continue to the next step, “Setting Up Content Server for Its Business Purpose.”

Note

On Linux: Add the destination path to the PATH statement. To do so, edit the 
two scripts <domain_home>/bin/startWebLogic.sh and <bea_home>/
weblogic92/server/bin/startNodeManager.sh by adding the 
following lines after the first comment block: 

LD_LIBRARY_PATH="$LD_LIBRARY_PATH:/u01/software/Apps/
WebLogic9.2/weblogic92/server/native/linux/i686"

PATH="$LD_LIBRARY_PATH:$PATH"
export LD_LIBRARY_PATH
export PATH
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Setting Up Content Server for Its Business 
Purpose

Once you have completed your Content Server installation, you are ready to configure it 
for business use. For instructions, see the Content Server Administrator’s Guide and the 
Content Server Developer’s Guide. The guides explain how to create and enable a content 
management environment including the data model, content management sites, site users, 
publishing functions, and client interfaces.
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